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Warranty and Liability

Note The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These Application Examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.
If there are any deviations between the recommendations provided in these
Application Examples and other Siemens publications – e.g. Catalogs – the
contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us – based on whatever legal reason – resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of Siemens Industry Sector.

Caution
The functions and solutions described in this entry predominantly confine
themselves to the realization of the automation task. Please also take into account
that corresponding protective measures have to be taken in the context of
Industrial Security when connecting your equipment to other parts of the plant, the
enterprise network or the Internet. For more information, please refer to Entry
50203404.
http://support.automation.siemens.com/WW/view/en/50203404

Siemens Industry Online Support
This entry is taken from Siemens Industry Online Support. The following link takes
you directly to the download page of this document:
http://support.automation.siemens.com/WW/view/en/77467630

http://support.automation.siemens.com/WW/view/en/50203404
http://support.automation.siemens.com/WW/view/en/77467630
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1 Overview
This document describes the FB45_S7_1500_Library block library with the new
SIMATIC block MOBY FB (FB45) for S7-1500. FB45 allows you to migrate existing
S7-300/400 RFID projects to S7-1500 in STEP 7 V13 and use them with little effort.
The main focus of this document is to describe
· the migration of an S7-300/400 RFID project based on FB45 to S7-1500 (TIA

Portal).
· the FB45 function block for the use of RF200/300/600, MOBY D/U with a

SIMATIC S7-1500 in STEP 7 V13.
· the functionality implemented through this block.

Furthermore, this documentation shows possible fields of application and helps you
integrate the library into your migrated STEP 7 project using step-by-step
instructions.

Note The name of the function block for the S7-1500 is still MOBY FB (FB45). This
facilitates migration of the existing project to the S7-1500.

1.1 Field of application

Diagrammatic representation
The diagrammatic representation below shows the most important components for
the possible use of the library.
Figure 1-1
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1.2 Functions

Communication between an S7-1500 CPU and an RFID reader is implemented via
an appropriate communication module and with the aid of FB MOBY FB (FB45).
The following table describes the core functions of the MOBY FB (FB45) function
block.
Table 1-1

Function Command sub_command (hex) Description

WRITE 01 - Write data to
transponder (max. 1024
bytes)

READ 02 - Read data from
transponder (max. 1024
bytes)

INIT 03 00 to FF hexadecimal value
with which the transponder
is written to

Initialize transponder

SLG_STATUS 04 RF200: 81h
RF300: 81h
RF600: 87h
MOBY D/U: 81h

Check reader status

SET-ANT 0A RF200/300:
01:Turn on antenna
02:Turn off antenna

RF600:
00: Turn off antenna 1,2
01:Turn on antenna 1
02:Turn on antenna 2
03:Turn on antenna 1,2

Antenna On/Off

MDS-STATUS 0B RF200: 83h
RF300: 82h
RF600: 84h
MOBY D: 83h

Check transponder
status

1.3 Hardware and software requirements

Requirements for this library
To be able to use the functionality of the library described in this document, the
following hardware and software requirements must be met:

Hardware
Table 1-2 Hardware components

No. Component Order no. Qty.

1. Communication module
(ASM 456 or RF180C)

6GT2002-0ED00
6GT2002-0JD00

1



1 Overview
1.3 Hardware and software requirements

6
FB45 for MOBY U/D RF200/300/600 and S7-1500

V1.0, Entry ID: 77467630

C
op

yr
ig

ht
ã

S
ie

m
en

s
A

G
20

13
A

ll
rig

ht
s

re
se

rv
ed

No. Component Order no. Qty.

2. Reader of the RFID families
RF200/300/600, MOBY D/U
(RS422 INTERFACE)

RF200: 6GT2821xxx
RF300: 6GT2801xxx
RF600: 6GT2811xxx
MOBY D: 6GT2602xxx
MOBY U: 6GT2698xxx

Up to 2

3. Reader cable Up to 2
4. RF transponder n

Note FB45 can also be used for communication between an S7-1500 CPU and an
MV420/MV440 code reading system (see \9\).

Software
Table 1-3 Software

No. Component Order no. Qty.

1. TIA Portal V13 SP1 6ES7822-1AE02-0YA5 1
2. GSD file for the

communication module
Available for download in Online
Support:
PROFIBUS:\6\
PROFINET:\7\

1
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1.4 Library resources and performance data

The following section gives you an overview of the size of the blocks of the
FB45_S7_1500_Library in the main memory.

Memory requirement
The following table shows the size of the library blocks in the main memory.
Table 1-4

Block Size in main memory
(bytes)

MOBY FB (FB45) 12437
Ident Profile 10603

Transfer time without an additional user program in OB1
The following table shows the average transfer times measured for the data
between the S7 CPU 1516-3 PN/DP and the RF360T transponder with the
RF310R reader via the ASM 456 communication module.
Table 1-5

Command Data length
(bytes)

Average
transfer time

READ
10 41 ms

100 60 ms
1024 316 ms

WRITE
10 38 ms

100 62 ms
1024 326 ms
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2 Blocks of the Library
The MOBY FB (FB45) function block is used for communication between an S7-
1500 CPU and an RFID reader via an appropriate communication module.

2.1 List of the blocks

The following table lists all blocks of the FB45_S7_1500_Library.
Table 2-1

Block Description

MOBY FB (FB45) FB MOBY FB (FB45) already includes the above-described
functions (Table 1-1) on a fully implemented basis.
The ident profile is called in this block.

Ident Profile An instruction to read and write data records from/to the
transponder. This instruction allows you to parameterize complex
command structures.

PLC data types MOBY CMD_e:
Definition of a command
MOBY Param_e:
Parameterization of an RFID channel
(reader)
MOBY SLG-Status_e:
Saving of the SLG (write/read device)
status

These PLC data types are
identical to the UDTs of
the existing FB45 for S7-
300/400. It is not
necessary to copy them to
the migrated project.

MOBY MDS-Status_e:
Saving of the MDS status

This PLC data type has
been newly created. If you
want to check the MDS
status, you have to copy it
to the migrated project.

Datatypes_Ident_Profil:
· HW_CONNECT_VAR:

To physically address the
communication module and the
reader and to synchronize the
function blocks used per reader
(ident profile)

· PIB_COMMAND:
For the ident profile, to
parameterize the commands.

Elements required for the
Ident profile. They must be
copied to the migrated
project.

PLC tags PIB_Constants:
Constants of the ident profile.
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2.2 FB MOBY FB (FB45)

The MOBY FB library block already includes the above-described functions (Table
1-1) on a fully implemented basis. The following figure and table show the call
interface of the MOBY FB (FB45) library block.
Figure 2-1

Table 2-2

Symbol Data type Explanation

IN
P

U
T

EN BOOL Enable input. Relevant only in FBD and LAD
representation.

Params_DB INT Parameter data block number for
an RFID channel (reader).

Params_ADDR INT Address pointer in the parameter
data block to the start of a “MOBY Param_e”.

O
U

TP
U

T ENO BOOL Enable output. Relevant only in FBD and LAD
representation.

Note Params_DB and Params_ADDR form a pointer to a data structure. This data
structure is defined by calling “MOBY Param_e”. A separate data structure must
be defined for each RFID channel (reader).

“MOBY Param_e”, “MOBY CMD_e”, “MOBY SLG-Status_e” PLC data types
These PLC data types are required to parameterize each RFID reader, define a
command and save the read out reader status (SLG status). You must define these
PLC data types in any data blocks.

Note For the description of these structures, please refer to the following manual:
“RFID systems FB 45 for MOBY U, MOBY D, RF200, RF300” (see \4\, Chapter 3
and the following chapters).

Note These structures are identical to the structures of the existing FB45 for S7-
300/400. As they already exist, it is not necessary to copy them to the migrated
project.
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“MOBY MDS-Status_e” PLC data type
This structure is necessary to save the read out MDS status.
Figure 2-2

Note This PLC data type has been newly created. If you want to check the MDS
status, it is necessary to copy it to the migrated project and create it in a data
block.

2.3 Function chart

The following chart shows the time sequences of a command. The signals shown
in the figure can be found in the “MOBY Param_e” PLC data type.
Figure 2-3

command_start

FB_active

ready

ANTENNA Antenna ON

Init_run
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2.4 Error and status display

An error has occurred in FB MOBY FB (FB45) when “error” = TRUE is displayed in
the “MOBY Param_e” parameter. This error can then be analyzed via the
“error_MOBY”, “error_FB” or “error_BUS” “MOBY Param_e” parameter.
Figure 2-4 PLC data type: “MOBY Param_e”

Note If error messages are displayed, the received data is invalid.

Additional error messages of the FB MOBY FB (FB45) function block
Table 2-3

STATUS Description Remedy

16#1A The “END” command is not
supported

· Change “command”
· Re-enable “command start”

16#1B The entered sub_command is
not supported.

· Change “sub_command”
· Re-enable “command start”

16#1C Error messages from the
communication module/reader
or the ident profile.

· Read out the status from the
instance DB of the ident profile
(“STATUS” (output of the
identification profile) in the multi-
instance DB of MOBY FB).

· For the meaning of this
STATUS, please refer to \5\,
Chapter 5.3.2.

Note All other error messages that are not described in Table 2-3 can be found in the
following Function Manual: “FB 45 for MOBY U, MOBY D, RF200, RF300”
(see \4\, Chapter 5).
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3 Migrating an RFID Project from S7-300/400
to S7-1500
In order to work with the new MOBY FB (FB45) and all other elements of the
library, you need a new STEP 7 V13 project or an S7-300/400 project that is to be
migrated to STEP 7 V13. The following sections describe the procedure for
migrating an existing S7-300/400 RFID project to S7-1500.

Requirements
For successful migration, the following requirements must be met:
· In addition to STEP 7 Professional (TIA Portal) and

STEP 7 V5.4/5.5, all software option packages used in the project must be
installed on the computer.

· The project must be consistent.
· The hardware included in the project must be included in STEP 7 Professional

(TIA Portal) or the project must be migrated without HW Config.
· Unencrypted migration of blocks is recommended.
· Consider the components that cannot be migrated.
· All open TIA projects must be closed.

Procedure
The following table describes how to migrate an S7-300/400 RFID project to S7-
1500.
Table 3-1

No. Procedure

1. Unzip your S7-300/400 RFID project.
2. Open STEP 7 V13 in the Project view.
3. Migrate the S7-300/400 RFID project.

“Project > Migrate Project > Source path > .s7p open > Migrate”

4. Open the device configuration of your S7-300 station.
5. Migrate it to S7-1500.

“Select the S7-300 station > Right-click > Migrate to S7-1500”
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No. Procedure

6. In the open window, select an S7-1500 controller and click on “OK”.

7. Adjust the IP address and subnet mask of the new CPU:
“Device configuration> Device view> Click on the PROFINET interface of the
CPU> Properties> Ethernet addresses> IP protocol”

8. In the Device configuration of the new station, open the Device view of the
communication module (see note) and customize the USER mode=“RFID
standard profile”:
“Properties> Device-specific parameters> USER mode> RFID standard profile”
Result:
· A new station appears in your

project.
· All elements that were only

relevant to S7-300 were
automatically deleted.

Note If the communication module was automatically deleted during migration, reinsert
it from the hardware catalog. Enter the PROFIBUS address (ASM 456) or IP
address (RF180C) and set MOBY mode and USER mode (see Table 3-1, No. 8).
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4 Working with the MOBY FB (FB45)
Function Block
This chapter consists of instructions for integrating the FB45_S7_1500_Library into
STEP 7 and instructions for integrating the library blocks into a migrated STEP 7
project.

Note The following description refers only to the RFID part of your project. If
necessary, you have to customize all other elements of the project.

4.1 Integrating the library into STEP 7 V13

In order to use the previously described functions of the new MOBY FB (FB45)
function block, first integrate the library into the configuration software. The
necessary steps are listed in the following table.
 Table 4-1

No. Procedure

1. The library is available on the HTML page from which you downloaded this
document. Save the 77467630_FB45_S7_1500_Library_V10.zip library to your
hard drive.

2. Unzip the library.

4.2 Integrating the library blocks into the migrated STEP 7
V13 project

Note You can also integrate the blocks of the library into a new project.

The following table lists the steps for integrating the blocks of the
FB45_S7_1500_Library into your migrated STEP 7 project. After that, you can use
the blocks of the library.
Table 4-2

No. Procedure

1. Open the STEP 7 V13 project you have already migrated.
2. In the “Global libraries” palette in the toolbar, click on “Open global library” or in

the “Options” menu, select the “Global libraries > Open library” command. The
“Open global library” dialog box opens.
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No. Procedure

3. Select the global FB45_S7_1500_Library.al12.

4. Use drag and drop to move all function blocks from the “Library_Blocks” folder of
the Library  to the “Program blocks” folder of your device.

5. Use drag and drop to move the “PIB_Constants” from the “PLC_Variables” folder
of the Library to the “PLC tags” folder of your device.

6. Use drag and drop top move “Datatypes_Ident_Profil” and all other PLC data
types (see Table 2-1) from the “PLC_Datatypes” folder of the Library needed for
FB45 to the “PLC data types” folder of your device.
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No. Procedure

7. Open the data blocks where you have created the PLC data types for
parameterizing the reader, defining the commands and saving the data.
Customize them accordingly.

8. Customize the start address of the communication module, “ASM_address”, in the
“MOBY Param_e” data type.

9. Customize the sub_commands in “MOBY_CMD_e” accordingly (see Table 1-1).

10. Set the open data block to “Non-retain” to ensure that the initial values are applied
each time the CPU is restarted:
“Properties> Attributes> Retain> Non-retain”

11. Compile the hardware and software of the S7-1500 station: In the Project tree,
right-click on the device and select the
“Compile > Hardware and software (only changes)” menu.

12. Download the new project to your controller.
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5 Using the new MOBY FB (FB45) Function
Block
This chapter shows you how to use the above-described functions (Table 1-1)
implemented in MOBY FB (FB45).

Note After restarting the communication module, a reset must be performed.

5.1 Resetting the communication module

The table below provides instructions for resetting the communication module.
Table 5-1

No. Procedure

7.  Open the data block where you have created the “MOBY Param_e” PLC data type
and enter the INPUT parameters (see \4\, Chapter 3.1).

8.  Enable “init_run” (control bit in “MOBY Param_e”, address: 19.3).

 Result:
The communication module has been reset.

5.2 Reading RFID data

The following table provides instructions for reading RFID data from the
transponder.
Table 5-2

No. Procedure

1.  Open the data block where you have created the “MOBY CMD_e” PLC data type
and enter the required parameters.

2.  Compile and download the changes to your device.
3.  Stop and restart your CPU to apply the changes to the DB.
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No. Procedure

4.  Enable “command_start” (control bit in “MOBY Param_e”, address: 19.1).

 Result:
The data read in this example can be found in DB45 starting with address 60.

5.3 Writing RFID data

The following table provides instructions for writing RFID data to the transponder.
Table 5-3

No. Procedure

1.  Open the data block where you have created the “MOBY CMD_e” PLC data type
and enter the required parameters.

2.  Compile and download the changes to your device.
3.  Stop and restart your CPU to apply the changes to the DB.
4.  Enable “command_start” (control bit in “MOBY Param_e”, address: 19.1).
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5.4 Initializing the transponder

The following table provides instructions for initializing the transponder.
Table 5-4

No. Procedure

1. Open the data block where you have created the “MOBY CMD_e” PLC data type
and enter the required parameters.

For more information on the memory size of the transponder to be initialized,
please refer to \4\, Table 3-9.

2. Compile and download the changes to your device.
3. Stop and restart your CPU to apply the changes to the DB.
4. Enable “command_start” (control bit in “MOBY Param_e”, address: 19.1).

 Result:
The value 16#A was written to the transponder.

Note Readers of the RF200 family do not support this function.

5.5 Checking the SLG status

The following table provides instructions for checking the SLG status.
Table 5-5

No. Procedure

1.  Open the data block where you have created the “MOBY CMD_e” PLC data type
and enter the required parameters.

sub_commands=81h and 87h are supported in FB45 (see Table 1-1).
2.  Compile and download the changes to your device.
3.  Stop and restart your CPU to apply the changes to the DB.
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No. Procedure

4.  Enable “command_start” (control bit in “MOBY Param_e”, address: 19.1).

 Result:
The status was saved in DB45 starting with address 1102.

5.6 Turning the reader’s antenna off/on

The following table provides instructions for turning the reader’s antenna off/on.
Table 5-6

No. Procedure

1.  Open the data block where you have created the “MOBY CMD_e” PLC data type
and enter the required parameters.

sub_command RF200/300
01:Turn on antenna
02:Turn off antenna

sub_command RF600
00: Turn off antenna 1,2
01:Turn on antenna 1
02:Turn on antenna 2
03:Turn on antenna 1,2

2.  Compile and download the changes to your device.
3.  Stop and restart your CPU to apply the changes to the DB.
4.  Enable “command_start” (control bit in “MOBY Param_e”, address: 19.1).

Result:
The antenna was turned off.
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5.7 Checking the MDS status

The following table provides instructions for checking the MDS status.
Table 5-7

No. Procedure

1.  Open a new data block (for example: DB45) and call the new PLC data type
“MOBY CMD_e”.

2.  Open the data block where you have called the “MOBY CMD_e” PLC data type
and enter the required parameters.

sub_commands=82h, 83h and 84h are supported in FB45 (see Table 1-1).
3.  Compile and download the changes to your device.
4.  Stop and restart your CPU to apply the changes to the DB.
5.  Enable “command_start” (control bit in “MOBY Param_e”, address: 19.1).

 Result:
The status was saved in DB45 starting with address 1084.
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6 References
6.1 Bibliography

This list is by no means complete and only presents a selection of related
references.
Table 6-1

Topic Title
/1/ STEP7

SIMATIC S7-300/400
Automating with STEP7 in STL and SCL
Author: Hans Berger
Publicis Corporate Publishing
ISBN: 978-3-89578-412-5

/2/ STEP7
SIMATIC S7-300/400

Automating with STEP 7 in LAD and FBD
Author: Hans Berger
Publicis Corporate Publishing
ISBN: ISBN: 978-3-89578-410-1

6.2 Internet links

This list is by no means complete and only provides a selection of useful
information.
Table 6-2

Topic Title
\1\ Reference to the entry http://support.automation.siemens.com/WW/view/en/77467630

\2\ Siemens Industry
Online Support

http://support.automation.siemens.com

\3\ S7-1500
Automation System

http://support.automation.siemens.com/WW/view/en/59191792

\4\ RFID Systems
FB 45 for MOBY U,
MOBY D, RF200,
RF300

http://support.automation.siemens.com/WW/view/en/21738808

\5\ RFID Systems
Communications
Module RF120C with
Application Blocks for
S7-1200 and S7-1500

http://support.automation.siemens.com/WW/view/en/77485950

\6\ PROFIBUS GSD Files:
IDENT

http://support.automation.siemens.com/WW/view/en/113562

\7\ PROFINET GSD Files:
Identity

http://support.automation.siemens.com/WW/view/en/22747865

\8\ SIMATIC Ident RFID
Systems SIMATIC
RF620R/RF630R
Configuration Manual

http://support.automation.siemens.com/WW/view/en/33287195

\9\ Code Reader Systems
SIMATIC MV420 /
SIMATIC MV440

http://support.automation.siemens.com/WW/view/en/73204122

http://support.automation.siemens.com/WW/view/en/77467630
http://support.automation.siemens.com/
http://support.automation.siemens.com/WW/view/en/59191792
http://support.automation.siemens.com/WW/view/en/21738808
http://support.automation.siemens.com/WW/view/en/77485950
http://support.automation.siemens.com/WW/view/en/113562
http://support.automation.siemens.com/WW/view/en/22747865
http://support.automation.siemens.com/WW/view/en/33287195
http://support.automation.siemens.com/WW/view/en/73204122
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7 History
Table 7-1

Version Date Modifications

V1.0 09/2013 First version
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